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1 SonarWiz - Edgetech 6205 R/T Demo Set-up Procedure 

This document helps explain set-up procedure for getting real-time (R/T) data 

acquisition running, using SonarWiz and DISCOVER and an Edgetech 6205 

bathymetric/sidescan sonar unit (or a simulated 6205 binned-bathymetry data source).  

In addition to the 6205 unit, you will need some type of motion reference unit (MRU) 

such as an Applanix PosMV, or the equivalent, to input position (latitude/longitude), 

heading, and attitude (roll, pitch, and heave) and time information. This will all need to 

be connected, configured, and running to accomplish the real-time acquisition.  For 

demonstration purposes, you may use a real Edgetech 6205, or simply play back a pre-

recorded, binned Edgetech JSF file, which had previously been recorded using the 

6205 bathymetric sonar device (the examples below will present this demonstration 

technique). 

1.1 Chesapeake Technology Software 

These downloads are available at www.chestech-support.com using your userid and 

password.  You need to download and install 2 items from Chesapeake Technology. 

(1) SonarWiz 6.05.0009 (current version as of 2/17/2017) Find this under the SonarWiz  

or downloads area here: 

http://www.chestech-support.com/
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Once downloaded, this software presents a graphic user interface (GUI) like this: 
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(2) Secondly, you need the real-time software item specific to the Edgetech 4600-6205, 

called the server. This is downloaded from the nearby **SonarWiz Servers section in 

www.chestech-support.com here: 

 

 

Then scroll down to this Edgetech 4600-6205 server and download and install it: 

http://http/www.chestech-support.com/ctisupport/sonarWizServerDownloads.asp
http://www.chestech-support.com/
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(3) Please demonstrate these features using Windows7, or Windows10. The 3D display 

capabilities of SonarWiz (new vessel editor, CTI3DViewer) are no longer able to be 

presented in WindowsNT, because WindowsNT does not support NET 4.5.1, and this 

level of NET is required for the displays.  

1.2 SonarWiz Bathymetry Data Acquisition Set-up 

Bathymetry data acquisition is different than sidescan or sub-bottom sonar acquisition, 

and this section describes the set-up unique to a bathymetry data acquisition scenario.  

Start by setting up a project using CREATE PROJECT, then take these next steps. 

1.2.1 VESSEL Definition and Export 

You need to start with VESSEL EDITOR and define the exact offset positions of your 

swath bathymetry sensor, GPS unit, and MRU (motion recording unit), since these 

positions are used in the numerical computation of the bathymetry "merge" process.  

 

 

Then for each sensor, use ADD SENSOR to define it. These example data are from the 

actual vessel FALCON SPIRIT: 
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You need to get the actual position offsets from the boat and sensors that you have set 

up, for the most accurate bathymetric survey results. Once the vessel definition is done, 

in the CONFIGURE EXISTING PROJECT dialog, EXPORT your vessel, so that the 

vessel definition XML filer, saved in the VESSELS sub-folder of your project, can be re-

used (IMPORTED) in subsequent projects: 
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For bathymetry data acquisition, you do not need to specify a NAVIGATION dialog, as 

you would for sidescan or sub-bottom data acquisition. The MRU and GPS data feed 

directly into DISCOVER, and the JSF data packets sent from DISCOVER to SonarWiz, 

contain all the position and attitude data necessary.  

1.2.2 Plan for R/T bathymetry displays 

Plan for bathymetry real-time acquisition display in the CTI3DViewer, by enabling the 

broadcast of bathymetry UDP packets. SonarWiz will communicate with the 

independent CTI3DViewer software item, by broadcasting UDP packets of information 

in real-time, which can be received by CTI3DViewer, and displayed in a scrolling 

bathymetry surface grid display. This is mesmerizing and well worth showing to any 

prospective customer.  There are two aspects to this setup: send port (define and 

enable UDP broadcast), and receive port (enable and define UDP reception).  

(1) SEND UDP PORT - define and enable this in the SonarWiz OPTIONS -> 

Bathymetry dialog like this: 
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The port number 6205 is somewhat arbitrary, as UDP has many available ports. The 

important thing to do is make sure that this broadcast port number is set the same as 

the receive port number. The receive port number will be set below, in the 

CTI3DViewer. 

Secondly, note that the UDP broadcast only occurs during real-time acquisition. In this 

way, bathymetry real-time displays differ from sidescan. The sidescan data, and the 

sidescan portion of an Edgetech 6205 JSF play-back or real data stream, is available 

for the SonarWiz waterfall display, as soon as the data are flowing into SonarWiz, even 

before QUICK-RECORD or RECORD have been pressed. In contrast, bathymetry data 

only show, and are broadcast on UDP, when the RECORD or QUICK-RECORD buttons 

have been pressed - that is, when RECORDING is active.  

1.3 Edgetech Software - DISCOVER 

The top-side unit software which is required to be running at the same time as 

SonarWiz, is the DISCOVER-Bathy version software, from www.edgetech.com and it 

may be obtained by contacting support@edgetech.com , a privilege available to any 

Edgetech customer. They can direct you to the FTP site where a current version of 

Discover-Bathy software installer may be obtained.  

Once installed (the current version as of 10/14/2014 - check with Edgetech in case 

there is a more current version),

 

the user will find these two important references on their disk: 

 

(1) The 6205 Hardware User Manual helps configure the serial COM port connections 

between the MRU and the 6205.  

(2) The DISCOVER Bathymetric User Software Manual explains how to run the 

software GUI.  

mailto:support@edgetech.com
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1.4 Edgetech Software 

The DISCOVER software itself installs and when run, presents a control GUI  

1.5 References 

Reading the reference documentation through, before trying to use the software and 

hardware, will really give you a good overview, and prepare you for set-up and running 

the system.  

1.5.1 Edgetech References 

The following 2 documents are your primary Edgetech references (current versions 

listed): 

(1) 6205 Hardware User Manual 0014877_Rev_B.pdf    8/7/2014 

(2) Discover Bathymetric User Software Manual 0014878_Rev_B.pdf  8/7/2014 

2 Customer Support Contact Information 

2.1 Chesapeake Technology 

Sending eMail to support@chesapeaketech.com is fastest, and please include your 

SonarWiz version number, and your license key number. The easiest way to send this 

is to click: 

Help -> MySupportInfo 

like this: 

mailto:support@chesapeaketech.com
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2.2 Edgetech Support 

Please see the Edgetech documentation for customer support contact information.  

3 DISCOVER and 6205 Setup Steps 

3.1 Edgetech DISCOVER / 6205 - real hardware set-up 

Follow the set-up steps in the DISCOVER software and hardware references. For a 

summary, from the 6205 Hardware PDF, paraphrased : 

1. Power up your 6205 interface box (plug in its power cable) - the unit which connects 

to MRU, and 6205 

2. Connect the 6205 via a large cable and special rear-panel connector - in comes 

sonar data 

3. Connect the MRU to COM1, and dual-head GPS to COM2, on the rear panel where 

you see 3 9-pin DB connector COM port inputs, on the 6205 interface box - since 

these provide: 

3.1 MRU brings in heave, pitch, roll "attitude" data (high-speed data) 

3.2 dual-head GPS brings in heading (high-speed) time (slow), and position (latitude, 

longitude) (slow) information 
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3.3 if a single-head GPS is used, then bring in heading (compass, gyro) on COM2 and 

GPS on COM3 

The reason - COM1 and COM2 are ultra-high-speed serial ports, and COM3 is a regular 

latency COM port - suitable for GPS. The attitude and heading data come in at high 

speed 

4. Run an Ethernet cable from the back of the 6205 interface box to the top-side unit 

PC, where you will be running DISCOVER-bathy, and SonarWiz. 

5. Power on the top-side unit PC and get DISCOVER-Bathy running 

6 . Get SonarWiz running, open or create a project, and select bathy settings, then get 

the Edgetech 4600-6205 server running, and set up your real-time display windows.  

7. When you have incoming data from 6205 to DISCOVER, click CONNECT on the 

Edgetech 4600-6205 server, and data flow packets will be shown in its message 

window. 

3.2 Edgetech DISCOVER - simulated sonar - JSF bathy DISK playback set-up 

Even without a real Edgetech 6205 unit, you can use the DISK function of DISCOVER 

Bathy, to play back a previously-recorded binned bathymetry JSF file, and SonarWiz 

can display and record this file. Here are the two steps to doing it: 

3.2.1 De-select bathymetry processing 

You may have to do this every time you restart DISCOVER, but it is easy and quick: 

(1) Select Bathymetry, then (2) Basic Controls: 

 

then (3) de-select the "Bathymetric Processing" check-box, so that the binned bathy 

data file will play back without further processing, and (4) click DONE: 
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Then you are ready to play back a binned JSF file and record it in SonarWiz. 

3.2.2 Start the DISK playback of a JSF file 

Here is some sample data recorded as 5-24m depth in Tampa Bay Florida, which may 

be presented in a demonstration project set up like this: 
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Bathymetry sample data - Tampa Bay Barges - Edgetech 6205 JSF data: 

www.chestech-

support.com/download/ctisupport/SampleData/BathyDataSet4_Edgetech6502_JSF.zip 

You can play back any of these 4 binned JSF files using DISCOVER, and re-record 

them in SonarWiz. Here is how to do that in DISCOVER: 

Start DISCOVER by clicking on the desktop shortcut icon: 

: 

then: 

1. select the DISK tab low on the DISCOVER GUI 

2. Browse to the JSF file you will play back, then 

3. Click the PLAY button when you are ready to play back the file 

 

Any time after that, when you are ready on SonarWiz, you may click CONNECT in the 

Edgetech 4600-6205 server and you will see active incoming data displayed in the 

server like this: 

http://www.chestech-support.com/download/ctisupport/SampleData/BathyDataSet4_Edgetech6502_JSF.zip
http://www.chestech-support.com/download/ctisupport/SampleData/BathyDataSet4_Edgetech6502_JSF.zip
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4 SonarWiz Setup Steps - DETAIL 

Here are SonarWiz set-up detail steps, which occur inside the summary description 

steps above. 

11/5/2014 -11/8/2014 eMails from John Gann: 

If you have the sidescan coming into SonarWiz then you are very close to having the 

bathy as well.  Make sure you have downloaded and installed the latest version of 

SonarWiz from our web site, and the current version of the Edgetech 4600-6205 bathy-

SS server. 

1. Under the Bathymetry tab, click on the Settings button and be sure that the Edgetech 

6205 sonar is selected in the drop down list at the top.  See below. 



SonarWiz-DISCOVER_Bathy6205Setup.pdf   Chesapeake Technology, Inc. copyright 2017-2018  

Rev 5, 2/17/2017 support@chesapeaketech.com 650-967-2045 Page 16 
 

 

 

2. On the 4600-6205 server, CONNECT to DISCOVER (assumes DISCOVER is 

running first, 6205 and MRU connected per Edgetech documentation). (NOTE: This is 

the same whether you have a real 6205 connected, or you are playing back a binned 

bathymetric JSF file in DISCOVER). 
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3. The next thing is to open the Data Acquisition tab in SonarWiz, and start RECORD or 

QUICK RECORD to get bathymetry data recording. Only then, can you see bathymetry  

displayed.  

 

4. Then use Tools -> CTI3DViewer to start the CTI 3DViewer, and select to enable real-

time bathymetry display, like this: 

 

then  
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The bathymetry set-up dialog has a UDP port number. Set this number to the same 

value as you used in SonarWiz (e.g. 6205) and the configure the color-coded depth 

display scale, like this: 

 

5-24m depth is suggested here specifically if you are simulating data for a 

demonstration, and are using the Tampa Bay Edgetech 6205 Sample Data Set 4, 

available here (4 binned JSF files, pre-recorded and binned during a Florida, USA 

survey). 

4.1 6205 Bathymetry / Sidescan Real-Time Display Options 

You can display sidescan from the 6205 as soon as data are flowing, but bathymetry 

needs to be in RECORD mode : 
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before you can see the data. We describe the 3 best display options below, for seeing 

your sidescan and bathymetry data R/T displays in SonarWiz. 

4.1.1 Sidescan - Waterfall Display 

As explained in the SonarWiz User Guide, you can select View -> Data Acquisition and 

select the WATERFALL1 or WATERFALL2 and display sidescan data channels 1,2 or 

3,4. You may right-click in the waterfall and select the display palette color. This data 

may be displayed as soon as it is coming into SonarWiz, even without RECORD being 

active. 

4.1.2 Real-time Mosaic - Sidescan + Bathymetry 

Using a combined sidescan/bathymetry sonar like the Edgetech 6205, you can display 

BOTH sidescan and bathymetry data in the real-time mosaic. The sidescan will display 

as soon as data are available. The bathymetry data will display as soon as data are 

available, and are being recorded.  
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4.1.3 Real-time Bathymetry-only display - CTI3DViewer 

When you have enabled real-time bathymetry for display in the CTI3DViewer, and the 

UDP port is receiving data (DISCOVER must be sending JSF packets, and SonarWIz 

must be recording them), and when SonarWiz is set up to broadcast UDP bathy data on 

the same UDP port as CTI3DViewer is set up to receive them, then you can see a real-

time presentation of the incoming bathymetric point-cloud like this: 
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The display is color-coded, moved (scrolls) right-to-left, and is color-coded as in this 

case, scaled according to a user-defined depth scale. The right-side control allows you 

to amplify the viewed data. 
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5 SonarWiz-DISCOVER Setup Issues 

5.1 Situation 1 - no position or attitude data showing 

5.1.1 Situation 1 Screenshot 

 

5.1.2 Situation 1 - Advice 

The issue is that there is no position or attitude data arriving into the SonarWiz system.  

My guess is that maybe you are not supplying that data to Discover?  SonarWiz is a 

mapping system and will of course need position and attitude data in order to produce 

and XYZ bathymetric solution. Get your MRU into a test situation and record serial data 

from it to verify outputs. 

6 Document Revisions 

2/17/2017 Rev 5 - Updated to note that several bathymetry database / interface 

upgrades have occurred since August, 2016, and using the current versions of both 

SonarWiz (6.05.0009) and the Edgetech 4600-6205 server (6.04.0004) is important 

for them to be in sync.  

7/16/2015 Rev 4 - Clarified in section 4.1 that "RECORD BATHYMETRY" needs to be 

active, not just Record Sonar" (e.g. sidescan), to enable the bathymetry R/T displays 

of data in mosaic, and CTI3DViewer.  

 


